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extensive fantasy world.

Also in this issue, Eduardo Rodriguez and Maciej
Sidorowicz show how to plein air paint changing
environments, and Klaus Pillon demonstrates how
to speed paint impressive water effects. James

Wolf Strehle teaches the fundamental elements of
perfecting perspective in fantasy art, Jan WeRRbecher
shows us how he creates his dark futuristic
illustrations, and much more!

Contributors
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BARTLOMIEJ GAWEL

Barttomiej Gawet is an artist and illustrator who has
worked for CD PROJEKT RED for the past nine years,
currently as Principal Concept Artist. He has worked on
every installment of The Witcher.

ASHLEY MACKENZIE

Ashley Mackenzie is a freelance artist and illustrator based
in Edmonton, Alberta, Canada. She earned a degree in
Illustration from OCADU in Toronto, Canada, and her
work has been featured in several famous publications.

SAM ECTOPLASM

Sam Ectoplasm was bornin 1986 in Marseille, France;
she moved to Montréal, Canada in 2009. Sam is a
self-taught illustrator who creates surreal and sensual
introspective art.

SEAN ANDREW MURRAY

Sean Andrew Murray is a freelance concept artist and
illustrator working in games, film and television. Sean is
the creator of The Great City of Gateway, a fantasy world,
with the game Gateway: Uprising releasing this summer.

KLAUS PILLON

Freelance concept artist Klaus Pillon graduated
in 3D production before focusing on his primary
love: 2D. Largely self-taught, he has worked
professionally since 2013 for games and movies.

For this month’s interviews, Ashley Mackenzie
shares her highly emotive illustrations for books and
magazines, and Barttomiej Gawet showcases his
work on The Witcher games. Traditional artist Sam
Ectoplasm discusses her raw, visceral illustrations,
and Sean Andrew Murray shares sketches from his
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If you’re having problems viewing the double-page spreads that we feature within
this magazine, then follow this handy little guide on how to set up your PDF reader!
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Top tips for viewing
For optimum viewing of the magazine, it is recommended that you have the latest version of
Adobe Acrobat Reader installed. You can download it for free here:

To view the many double-page spreads featured in 2dartist magazine, you can set the reader
to display “two-up’”, which will show double-page spreads as one large landscape image:
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Jump to articles

In the Contents pages, we have direct links to all articles within the magazine. If a certain
article catches your eye, simply click (or tap on handheld devices) on the page number within
the Contents, and you will be taken straight to that article.

Download resources

Whenever you see this symbol, be sure to click it to download
free resources to accompany that article! Alternatively, head
to www.2dartistmag.com/downloadable-resources

For lots more tutorials and exclusive articles, visit

www.2dartistmag.com

2dartist magazine is available as a downloadable PDF magazine. If you have an iPad or iPhone, you can drag your
magazine into your iTunes library - it will automatically add the PDF to your bookshelf in your iBooks app!
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The Artist

Barttomiej Gawet
gawel.artstation.com

Interviewed by:
Annie Moss

Barttomiej Gawetis an
artist, and illustrator

who has worked for CD
PROJEKT RED for the past
nine years, currently as
Principal Concept Artist.
He has worked on every
installment of The Witcher.

Dramatic
game concepts

Barttomiej Gawet, Principal Concept Artist at CD PROJEKT RED, discusses the
importance of storytelling in art, and showcases his work on The Witcher games ©




©CD PROJEKT S. A.




2DARTIST MAGAZINE | Dramatic game concepts Concept art for UMA (short for Ugliest Man Alive), a character cursed in The Witcher 3: Wild Hunt. He is first
encountered by Geralt as a pet to the Bloody Baron, but Geralt and Yennefer later attempt to remove the curse
Art direction: Adam Badowski ©CD PROJEKT S. A.

Drawing has been a life-long passion for
Barttomiej Gawet, who began drawing when

he was only four years old, motivated by his
father’s love of Baroque style oil painting. The
child-like approach is something he has tried

to maintain over the years by attempting to

find meaning in artwork without judging them.
Instead Barttomiej looks for meaning in the story
behind an artwork, attempting to uncover the

essence of what the artist is saying in each piece.

Having worked for CD PROJEKT RED on The
Witcher projects for the past nine years,
Barttomiej has a wealth of experience creating
exciting concepts which incorporate complex
narratives and multiple characters. This month
Barttomiej shows us his recent works and
talks to us about the importance of being kind
to yourself, how breaking projects down to
small steps helps him stay focused, and why

he thinks it’s important to work with pencils.

2dartist: Hi Barttomiej, thank you for talking
to 2dartist! Can you kick things off by telling us

a little bit about yourself and your work?

Barttomiej Gawet: Hi, thank you for having me.
Well, ’'m thirty-eight-years old and | live in Poland,
Warsaw. I'm very happy to have a great family

(afiancé and a two-year-old son) who keep me

busy all the time! Also | have a great job which

happens to be my passion. So, 'm lucky.

For my work | just do what | have been doing

my whole life. | started drawing when I was

four or five years old and since then | haven’t

stopped. So | was lucky enough not to have to

think about what | wanted to do in my life. The

path was clear for me: | wanted to create art.

What | didn’t expect was to be working in the ‘,\

videogames industry. That was a surprise.

2da: Storytelling is really important in 7 )|
your work, how do you ensure there is a )

clear sense of narrative in your work? ] \“&

BG: The storytelling is the most important part
of an artwork for me. As a viewer | always try to
find the meaning of a piece. It is like having the

open mind of a child. The goal is to see without

judging or making predictions. What is really

going on in this artwork? What does the artist
want to say? | love it. That is the reason why | love
contemporary art so much. You can find so many

meaningsin a piece of art. It can surprise you. »

2DARTISTMAG.COM




Foglets, shown on a card made for Gwent: The Witcher Card Game
Art direction: Katarzyna Redesiuk ©CD PROJEKT S. A.
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If you could write a letter to your younger self, just
starting out as an artist, what advice would you give?

Be yourself. Don’t worry about what others say. Be brave, read more books and have a lot of fun.

What do you think has been most influential to your

career success?

I think my father and his paintings. He was my first very powerful inspiration. Working for CD PROJEKT

RED has also been a great place to grow.

Having said that; in my works | always try to stay
focused on a subject, the mainidea, and theme. |
always ask myself some questions: what is really
important here? What is the key idea? From this
point | try to find some answers for my questions
by using a visual language. What is the best light
for this theme? Which composition works the
best? What colors will | use? And so on. You could
say that everything from form and composition,

to light and color is subservient to storytelling.

2da: What made you want to

pursue a career as an artist?

BG: When | was very young | used to see my father

copying old Baroque paintings with oils. I still

2DARTISTMAG.COM

remember the smell of the paint. | was fascinated

by my father and his process of painting; very

quiet, almost like a meditation. The pictures that

he painted were very small and full of detail. There
was a lot of mystery in them. Soon | realized that if |
drew | would have his attention, his and my mothers.

So | drew. And after a while | started to enjoy it.

2da: What are your preferred tools

to work with and why?

BG: | have always preferred pencils, maybe because
it was the very first tool | used. | love oils, for obvious
reasons, but unfortunately | haven’t used them for a
while. And | love to work in Photoshop, because it is

so easy. This ease can be dangerous though, because

after a long period of time only using Photoshop
your brain can become very lazy and you will have
a lot of trouble just to draw. That's why I'll never give

up pencils but my real dream is to get back to oils.

2da: Which tools, techniques or software would

you like to explore in the future, and why?

BG: Oh, definitely some 3D software. | wish | could
do it sooner because it can easily add new quality to
your work. | have some experience in ZBrush and |
really love it. It's so easy to use. It took me two weeks
to learn it and then | was able to do the character
heads for The Witcher 2. But since then | haven’t
used it as much as | wish. I'd also like to learn some
rendering software like KeyShot which could speed
up my work, especially now, when I’'m working on

illustrations on Gwent: The Witcher Card Game.

2da: Which artist or group of artists

particularly inspires your work?

BG: There are a lot of names on the list. | love Russian
painters from the beginning of the nineteenth
century like llya Repin. I also like American illustrators
and artist like the Wyeth family, and Polish artists

like Jacek Malczewski or Aleksander Gierymski,

Olga Boznanska, and Jozef Chetmonski.



2da: If you could meet any artist (past or

present) what would you ask them and why?

BG: Probably some questions about life and
art, because | want to learn from the mistakes
of others rather than make my own. That is
why | like biography books. | think | would meet
Andrew Wyeth and ask him about his technique

of watercolors, which was incredible.

2da: Where (and when) do you feel

you are at your most creative?

BG: Definitely when | travel alone, when | go to
new places and meet new people. | can focus
more on myself and my feelings. That is the

most inspiring time for me. Ideas just flow into

my head. | guess | need to travel more often.

2da: Artist block is a problem for many creative
people. Can you share a couple of tips you

use when the inspiration stops flowing?

BG: It just happens. | think it is much easier when
you work with other people. You can always talk
to someone, share the frustration and get some

feedback. | don’t know how it is when you work

alone, as I've always worked with others. »

WITCHER

wn.b\ HUNT







" Promotional material for The Witcher 3: Wild Hunt
Art direction: Adam Badowski ©CD PROJEKT S. A.
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One of the promotional images for The Witcher 3: Wild Hunt | guess that a simple walk can sometimes
Art direction: Adam Badowski, Base render: Pawet Brudniak ©CD PROJEKT S. A. help. Also changing a task and going back to
it after a while could be useful. But | think the
mostimportant thing is to be forgiving and
kind to yourself. It is like the weather; there are
moments of storm but after, there is sun which

you can enjoy, or at least it will stop raining.

“l visualize pictures
instead. It is like having a
camera in your head which
records a picture”

2da: What has been the project you

have most enjoyed working on?

BG: I'm working on it now: the illustration for Gwent:
The Witcher Card Game. It is the first time in my

career when I have had so much freedom and fun.

I do each illustration in a different way and
learn from the process. The mostimportant
thing is that I have the privilege of working with

amazing talents from whom I learn a lot.

2da: What initial steps do you take when you

are first given a brief for a new project?

BG: First | read it carefully and | start to think about

it. | think in pictures, which means that | don’t have
any particular thoughts, | visualize pictures instead. It
is like having a camera in your head which records a
picture and when you don't like the angle of a shot,
you can change it to a different spot. Also, | look

at a lot of pictures, paintings, movies and so on.

After a while ideas start to come and | try to catch

themin a simple drawing. When | have a core

idea I try to figure out the composition, light and

soon, in asimple drawing, to create a distilled

idea. When it is accepted, | can start to finish it.

2da: How do you keep yourself motivated

when working on a difficult project?

BG: | do small steps at atime. When I have a
huge mountain to climb, I usually don’t think
about my motivation, I just think: I'm doing this,
because climbing a huge mountain s a great

project. Itis easier if you just focus on each step.

I remember working on the cover art of The Witcher
3: Wild Hunt, which was a mountain for me. | worked
on this for half a year and | did (with help of some

outsourcing) more than six hundred propositions. »



A card made for Gwent: The Witcher Card Game featuring a lubberkin A card made for Gwent: The Witcher Card Game featuring Maria Barring, better
Art direction‘:‘Ka_tirzyna Redesiuk | known as simply “Milva” or “Kanial.” She is a female archer and one of the few
[ ] non-dryads tolerated in Brokilon. Art direction: Katarzyna Redesiuk

® “Chorts are smaller than fiends, true. But still big enough to kill.” A card made for
Gwent: The Witcher Card Game. Art direction: Katarzyna Redesiuk
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® Promotional image for The Witcher 3: Wild Hunt
Art direction: Adam Badowski, Base render: Digic Pictures ©CD PROJEKT S. A.
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Ekkima on a card made for Gwent: The Witcher Card Game
Art direction: Katarzyna Redesiuk

Is there anything you think budding artists should
try to avoid?

I think everyone has his or her unique path to go on but I can tell you what I'm trying to avoid. | try
not to be influenced by other artist’s works, especially from popular sites like ArtStation. | choose my

inspirations very carefully.

2DARTISTMAG.COM

Only focusing on each proposition and idea for

a cover prevented me from quitting my job.

2da: When you're not working hard on your

art, what do you like to do with your time?

BG: | really don’t have too much spare time.
I do most of my art at work, so at home | try
to do my own art. | play a lot with my son

and I also read some psychology books.

2da: Finally, where will we be able to see your work

next? Are there any projects we should look out for?

BG: Now I'm working on Gwent: The Witcher
Card Game, there you can find plenty of
my works and the beautiful art of other

artists. The gameitselfis amazing. @

Thank you Barttomiej for talking to 2dartist!



A card made for Gwent: The Witcher Card Game. Ocvist{
dragon from the Quartz Mountain reportedly bested by Yat
Art direction: Katarzyna Redesiuk e
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The Artist

/
Ashley Mackenzie

ashmackenzie.com

Interviewed by:
Annie Moss

Ashley Mackenzie is
afreelance artist and
illustrator based in
Edmonton, Alberta,
Canada. She earned a
degreein Illustration

from OCADU in Toronto,
Canada, and her work has
been featured in several
famous publications.

Emotive editorial
illustrations

We talk to freelance illustrator Ashley Mackenzie about her creative
process and working her way through creative blocks ©




Allimages © Ashley Mackenzie



A poster illustration for OCADU’s 99th graduate exhibition



Ashley Mackenzie is a Canadian artist and Ashley’s signiﬁcant artwork
illustrator who specializes in editorial I've always dealt with a lot of self-doubt and ongoing worries about whether or not I'd be able to make it as
illustrations. She also enjoys creating concept an illustrator. This piece was for the New York Times book review and it was one of my first few published

art and decorative illustrations. She has illustrations. Being able to complete a piece that | was proud of in a 3-day timeframe for a client | could barely

won awards and recognition for her work imagine working for as a student really finally legitimized the idea that | would actually be able to make a

Tl e e AN B e living fromiillustration. | quit my part-time job a few months later and despite some ups and downs | still feel

incredibly happy and grateful to be doing illustration full-time.

OCADU, Canada. Ashley uses her imagination
and visual vocabulary to create illustrations
that solve problems, or find simple visual
solutions to complex themes and ideas. Her
work has been published in several famous
publications including Scientific American
and the New York Times Magazine. When not
drawing she can be found reading, playing

videogames or thinking about her next project.

2dartist: Hi Ashley, thank you for talking to
2dartist! Can you kick things off by telling us

a little bit about yourself and your work?

Ashley Mackenzie: I'm a freelance illustrator

who tends to mostly create editorial work

with a focus on finding simple conceptual

visual solutions to complex ideas.

2da: Your work is often highly emotive
and allegorical; can you tell us a bit

about the ideas behind your work?

AM: It really varies from piece to piece, however, |
always try my best to approach an article searching
forvisual and conceptual clues that | can then

tie together into an illustration. | think the best
illustrations are not only able to stand on their own
but are further enhanced by an understanding of the

article, so that is something | strive for in my work.

“There are always new
problems to solve and
I’m always learning
and growing”

2da: What made you want to pursue

a career as an illustrator?

AM: | have always loved image-making, whether
it was drawing or painting, and | loved how open
theillustration industry is from editorial and
publishing, to concept art and product design,
and so on. There are always new problems to

solve and I'm always learning and growing,

2da: What are your preferred tools
to work with and why? »
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If you could write a letter to your younger self, just starting out as an artist, what
advice would you give?

I would probably say: “Don’t be so hard on yourself, you're doing fine. It's okay to take a break now and then.”

Is there anything you think budding artists should try to avoid?
I'd say try not to avoid anything! Experiment as much as you can, find what interests you, what ideas you find engaging, and what forms catch your fancy and
just explore. It's a good way to start finding your voice while keeping an open mind to any new paths or possibilities.

® Anillustration for tor.com for the short story Some Gods of Old El Paso
by Maria Dahvana Headley

2DARTISTMAG.COM
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® One of my thesis illustrations about how the ease of finding information with
technology inhibits our ability to retain details and be truly knowledgeable

25
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AM: Most of my early work was a hybrid of
digital and traditional techniques, with the initial
drawing done in graphite and the color applied
in Photoshop. Lately I've been striving to find

a purely digital workflow without sacrificing

the elements of working traditionally. These
elements really appeal to me because they are
much more appropriate for the extremely short

timelines offered for most editorial work.

2da: Are there any tools, techniques, or software

you would like to explore in the future, and why?

AM: Mostly | am just trying to become more
proficient with digital techniques because in
many ways they're still foreign to me and often

quite different from traditional methods.

An illustration for the Walrus about the
gender divide in classical conducting

2da: Which artist or group of artists

particularly inspires your work?

AM: Oh there are so many; James Jean, Sam Weber,
Dadu Shin, Jillian Tamaki, Sam Wolfe Connelly,
Sachin Teng, Shaun Tan, Joao Ruas, Nimit Malavia,
Victo Ngai, Dave McKean, Tomer Hanuka, Ivan
Solyaev, Andrew Hem, Teagan White, Samantha
Mash, Kevin Hong, Joy Ang, Kelly Smith, Miranda
Meeks, Tran Nguyen, Lynn Scurfield, Rachel Suggs,
Corinne Reid, Zach Montoya, Nicolas Delort,

Richie Pope, Natalie Hall, Rovina Cai, and so

many more but I'm running out of space now!

“For the most part | actually
get my best ideas when I’m
out of the house”

2da: Where (and when) do you feel

you are at your most creative?

AM: For the most part | actually get my best
ideas when I'm out of the house, and if 'm
working from my home studio I'm usually most
productive during mid-afternoon and late at
night. Obviously work doesn’t always cater

to those times, so | try to stay flexible as that’s

what I've found works best over the years.

2da: Artist block is a problem for many creative
people. Can you share a couple of tips you

use when the inspiration stops flowing?

AM: Usually when I'm really stuck | do something

completely unrelated, whether that's walking,




working on a different project, or just going back to
basic fundamental studies (figure drawing, still life,
master studies and so on). It serves as a good palette

cleanser and also improves your technical skills.

2da: What has been the project you

have most enjoyed working on?

AM: It would be a tie between doing Tor covers and
illustrations for science editorials. Tor always offers
really engaging stories and a lot of creative freedom
where as the science editorials always offer really

interesting and unique ways to put ideas together.

2da: What initial steps do you take when you are
first given a brief for a new project? Do you dive

straight in or do you have a more analytical process? »

2DARTIST MAGAZINE | ISSUE 134

® Artist Timeline Ashley’s careerso far

2013: Finished thesis at OCADU, Canada, Gold

Medalist for the lllustration program

2013 First published editorial piece in
Canadian Lawyer magazine

2013: New York Times book review

2013: First piece for Scientific American

2014: Quit part-time barista job to pursue
illustration full-time

2014: First piece for tor.com

2014: Had two of my Tor pieces accepted into
the SOI book annual

2014: |llustrated the poster for OCADU’s 99th
annual graduate exhibition

2015: Released first limited edition print run
through Black Dragon Press

2015: Full page illustration in New York
Times Magazine




What do you think has been most influential to your
career success?

Social media has been incredibly useful for my career, it’s allowed me to reach so many people and
also engage with many art directors. The support | received from my professors and other working
illustrators has also been invaluable!

® Anillustration for tor.com for the short story
The Destroyer by Tara Isabella Burton
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AM: | definitely have an analytical approach,
maybe even too analytical! | read through the
brief or the article a couple times and take notes
on any key phrases or ideas that | think could be
used to make something out of, then | make a

list from visual cues that | think would work well
with the piece, and finally | start sketching things
out to see what actually reads well as an image.
Sometimes it takes thinking and drawing through
some pretty downright awful ideas to stumble

across a concept that’s genuinely interesting.

2da: How do you keep yourself motivated

when working on a difficult project?

AM: | try to break the project down into smaller goals

that are easier to finish, and | find that helps keep a

good momentum going. If 'm really stuck | will stop

and do some studies or if | have time go for a walk to

clear my head and come back to it with fresh eyes.

2da: When you're not working hard on your

art, what do you like to do with your time?

AM: Definitely still need to work on finding
that work/life balance but the odd times when
I’'m not working | enjoy reading, watching

movies, and playing videogames.

2da: Finally, where will we be able to see your work

next? Are there any projects we should look out for?

AM: Right now | have a couple of poster illustrations
in the works as well as some editorial work,
plus along termillustration project that I'm

hoping to wrap up over the next few months. @

® One of my thesis illustrations about how we may never be able to fully comprehend the
complexities of the universe, but knowing our limitations shouldn’t hinder our attempts to do so

An illustration for Science News about microbial dark
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3dtotalPublishing

3dtotal Publishing is a small independent publisher specializing
in inspirational and educational resources for artists. Our titles
proudly feature top industry professionals who share their
experience in step-by-step tutorials and quick tip guides placed
alongside stunning artwork to offer you creative insight, expert
advice, and all-essential motivation.

3dtotal Publishing is an offspring of 3dtotal.com, a leading
website for CG artists founded by Tom Greenway in 1999.

LATEST TITLE

BEGINNER’S GUIDE
TO SCULPTING
CHARACTERS IN CLAY

AN N
'BEGINNER’S GUIDE TO
SCULPTING CHARACTERS
IN CLAY

PRE-ORDER NOW!

3dtotalpublishing.com | 3dtotal.com | shop.3dtotal.com










The Artist

Sam Ectoplasm
samectoplasm.gallery

Sam Ectoplasm was
bornin 1986 in Marseille,
France; she moved to
Montréal, Canada in
2009. Sam is a self-taught
illustrator who creates
surreal and sensual
introspective art.

{ ARTI ST SPOTLIGHT

. Surreal and
“ visceral illustrations

oy This month we speak to self-taught artist Sam Ectoplasm about her
; beautifully visceral imagery that explores what it means to be human ©

NUDITY

WARNING

Allimages © Sam Ectoplasm
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For Sam Ectoplasm art is not only a way to
understand what it means to be human, but
is also a way to delve into the subconscious
and discover the hidden self. She incorporates
different organic forms into her art, which
include sinuous viscera and twisting hair. This
results in surreal and beautiful drawings that

give you a sneak peek into her inner-self.

Sam is currently studying for an Art History
and Museology degree at Université du
Québec a Montréal, Canada, and spends much
of her free time visiting exhibitions and writing
essays. She also enjoys visiting libraries
looking for inspiration in old anatomical and
vegetal drawings. Sam talks to us about her
creative process, the motivation her close
friends and family have inspired in her, and the

importance of enjoying your artistic journey...

2dartist: Hello Sam! Thanks for talking to
2dartist. First off, could you introduce yourself

with a bit about your background and projects?

Sam Ectoplasm: Hello! I've been drawing for
as long as | can remember. | studied visual

arts in Aix en Provence, which allowed me to
experiment with various media, but | developed
my practice of mixed media drawing by myself.
After moving to Canada in 2009, | started drawing
more consistently and developed my current
style using pen, ink, pencils, and watercolor

on paper. | have been part of exhibitions in
Canada, the USA, Japan, and Ireland. I have had
a few private commissioned works or themed
exhibitions, but I mostly work on personal
themes. For me drawing is a way to understand

my subconscious and it helps me to heal.

2da: What, or who, encouraged you

to take up a career as an artist?

SE: | have always known | wanted to make art; it
has always been a sanctuary of soothing solitude
and an essential activity for me. However, it

has taken me some time to develop this desire
because | was lacking confidence. | didn’t find
university very useful because, in my opinion,

it tries to make art students fit in the mold of
contemporary art — where vaguely intellectual
concepts and poor aesthetics are king. | found
meeting other artists dedicated to their work
such as my boyfriend and close friends to be
more inspirational, and this has given me the

motivation to take up art as a professional.

2DARTISTMAG.COM

Luckily, my family has been very supportive
of my choice to become a professional artist,

it helps that my mother is also an artist!

2da: You have said that your work celebrates
the complexity of the human psyche and body,
can you tell us more about these ideas?

“As | am an anxious person
about both my mental and
physical health, | feel | need
to create images that not only
represent this fear of death

and decay, but also the beauty

and strength of life”

SE: In my artwork | study the principle of the
living, in the body, as well in all forms of life on
earth. Each element can work alone or together;

the microcosm mirrors the macrocosm and

some patterns repeat themselves. Everything

in reality is really intertwined and complex. The
mechanisms of life include expansion, decay, and
death, which can be overwhelming for a lot of us

and is often left unaddressed in modern society.

As | am an anxious person about both my mental
and physical health, | feel | need to create images
that not only represent this fear of death and

decay, but also the beauty and strength of life.

Organic forms, inspired by nerves, organs, hair,
and muscles, have become embodiments

of psychic and emotional states that are all
woven together. Making this look sweet and
beautiful is a pretty secular idea; indeed, in
the Middle Ages each organ was linked to

an emotion and a type of temperament and
health. For me the essence of art is trying to

understanding what it is to be human. »

Petit dessin marie - pen and ink on paper - 5 x 7” (2016)










® Le Piége - pen, ink, and pencils on paper - 22 x 28” (2016)
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2da: Your work often depicts surreal, visceral
figures with a touch of Art Nouveau styling. How

have you developed and adapted your style?

SE: My style came gradually and naturally,
it developed through experimentation and
practice. | first began using just a pen but
then started to add watercolors and then
pencils. At first, the watercolor and pencils
were used more to color the bodies, but

I'm now detaching from this practice.

Art Nouveau is an appealing style to emulate;

| like the movement, fluidity, and excessive
ornamentation. | like doing both academical
drawings of portraits and nudes, which are

both challenging and rational, mixed with the
freedom and randomness of the organic motives

that I draw freehand in a meditative state.

Each emotion is visually expressed by the
waves of different textures and elements,

made possible by using various mediums.

Metamorphosis | - pen, ink, and pencils on paper - 14 x 17” (2016)

2DARTISTMAG.COM

2da: Where do you turn to for inspiration?

Are there any artists you like to reference?

SE: I mainly get my inspiration from internal
paradoxes and spiritual questions; | believe
that drawing has its own life force and it
reveals to me something from my own

subconscious that was previously hidden.

I draw inspiration for textures and colors from

vegetal and anatomical photos and old drawings.



My tastes for artists is always changing

and encompasses a wide variety of styles,
so it’s difficult to list them all here, but to

try to name a few | do like the following:
Hans Bellmer, Takato Yamamoto, Allison
Sommers, Gustave Adolf Mossa, Jason Shaw

Alexander, Lux Xzymhr, and Jean Delville.

“Mastering observational
drawing trains the eye and
will make you feel more at
ease with your tools. Once
you have mastered it you can
always detach from it and
explore something different”

2DARTIST MAGAZINE | ISSUE 134

should go hand in hand with the personal
subject matter and sensitivity of the artist.
Every artist develops his or her practice by
watching what others do, but they have to find

their own personal expression eventually.

I would encourage artists to think about their

subject, what matters to them, and what’s

2da: What advice can you give to our SE: | developed this way of working because particular about their vision. Mastering

readers who want to develop their drawing it fits in with the feelings I want to convey observational drawing trains the eye and will

techniques in a similar manner? to my drawings. Style isn’t a goal in itself; it make you feel more at ease with your tools. »

® Metamorphosis Il - pen, ink, and pencils on

paper - 14 x 17” (2016)
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® Ancétres - pen, ink, and pencils on paper mounted on wood board - 36 x 36” (2014)



Fantéme dans un Verre - pen, ink, and pencils
on paper - 14 x 17” (2016)

=

Once you have mastered it you can always
detach from it and explore something different.
I would encourage artists to experiment
gradually, like I did, with different mediums
and see which one feels the most exciting and
meaningful for what the artist wants to say.
Also, they should be observing other works of
art, making sketches and studies, documenting
ideas, textures and collecting them in a file to

go to for inspiration, and have fun above all.

2da: What are your preferred tools

to work with and why?

SE: | prefer working with sharp tools such
as micro point pens and pencils that allows
precision and sharpness. | like the fact that
it takes a long time to achieve a figure, but
going line by line is a devotional ritual that
makes you learn patience. | also love the
smooth and sensual feeling of the colored

pencils, for blending and shading.

| like to balance these with a more spontaneous

medium that can create random forms and

allows me to see hidden images, like in clouds
of watercolor. Black India inkis also a long
time favorite for making sharper and bigger
areas of darkness. Mostly, | choose tools
according to how they can create harmony or

contrasts in the various areas of the drawing,.

2da: Do you have a particular place you like
to go to draw? Do you create your works

in a studio, at home or out in nature?

SE: I work in my apartment which is basically a
cube with few windows. | draw in a small corner
of the flat | share with my partner, who is a
painter. | am lucky to have a big table to work on
that was given to me by my father’s partner who
was a graphic artist. There’s not a lot of space

so everything has to be organized and tidy.

2da: What has been your favorite

project to work on so far?

SE: Désincarnations is a series | created in 2014
and is probably my favorite body of work because

this was when my practice began to evolve; | »



® Le Piége Chapitre Il - pen, ink, and pencils on paper - 15 x 19” (2016)
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was taking risks by trying new techniques. It was
evolving before my eyes, which was a very thrilling
sensation. It’s more difficult when | participate in

a themed exhibition, with a deadline. There are
always drawings that | find more accomplished
than others, but | have the freedom to do

what | want and that’s precious to me.

“l think it’s only with time,
practice, dedication, and
perseverance that artists gain
confidence in what they do”

2da: How do you deal with a challenging

project? Do you have any tips for our readers?

SE: Sometimes when starting a project the most
challenging thing to do is to kick yourself in the
butt and face the “blank page.” | am regularly,
like a lot of artists, confronted with the fear of
failure and lack of confidence. Steven Pressfield
addressed it well in “The war of art” (I would
recommend reading this for aspiring artists

that are having trouble getting to it). | think

it's only with time, practice, dedication, and
perseverance that artists gain confidence in what
they do. Avoiding putting too much pressure on
oneself is essential; art is an occupation that is
supposed to make you discover yourself, and

about enjoying the moment, not winning a race.

2da: Are there any other skills and techniques
you would like to learn in the future? Are there

any materials you would like to experiment with?

SE: There are so many things that | would like
to learn! In my drawing practice | still want to
try out new possibilities and new techniques,
such as engravings. | would also like to work

more with textile and learn embroidery.

2da: What has your experience as a freelance

artist been like? What lessons have you learned?

SE: lam still learning a lot! It is hard to multitask,
answer emails, set up an online shop, create
galleries submissions, and so on, all at once
because | want to have time to create artwork. |
have learned that the way you present yourself

and value your work is important too.

Being proactive is also a huge part of it but
also not overwhelming yourself is important
too. I tend to want to be seen all over social

media and participate in every exhibition »

2DARTISTMAG.COM

Die Puppe - pen, ink, and pencils on paper - 22 x 30” (2016)
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Le Chant du Cygne - pen, ink, and pencils on paper mounted on
wood board - 16 x 20” (2016) Armistice - pen, ink and pencils on paper - 22 x 30” (2014)

This triptych is from 2013 and reflects an intense period of work and experimentation, where | was looking for my voice. | was a bit uncomfortable
with using colors so I did all the outlines and shadings with black pen first before adding the colors with watercolors; | was very nervous of the
result! It's a very detailed drawing that took me a month to complete.

It was the first time | used visceral and vegetal imagery so accurately, opening bodies, because of the theme of love and co-creating bonds. | felt
I needed to depict my feelings and thoughts in a dramatic way, to be honest and raw about it. | drew from photographs of my partner and me;
drawing us was a way to document, commit to, and sublimate our relationship. There’s a naive and authentic feel to this drawing, even though |
would do some elements differently today.

a7



but, lately, I have found that slowing down
the pace and concentrating on a few,

consistent projects is better for me.

2da: What does a working day in

the life of Sam look like?

SE: It's always changing, according to what’s
the priority and I hope to find a routine that
sticks. Usually, it’s trying to work on drawing
for a big chunk of hours, without distraction.

| find the more you do, the more you want to,
so it helps to start in the morning. After that,

a break is needed so | go out for a walk and
combine it with errands like going to the post
office to ship artworks. A lot of the time is also
updating my etsy shop, website, or social media,
as well as sometimes preparing an exhibition
proposal. Also, | need a lot of daydreaming,
writing down ideas and concepts and resting, |

feelit's a huge but unnoticed part of making art.

2da: How do you like to spend your time

when you aren’t creating beautiful art?

SE: | am currently finishing my Art History
and Museology degree at Université du
Québec a Montréal, so | am spending a lot
of my time reading, visiting exhibitions, and
writing art essays. | love spending time in
libraries looking for inspiration and learning
more on a particular topic. | like sewing and
embellishing clothing, cooking, walking in
the parks of Montreal, and meeting friends;

I find pleasure in the simplest things.

2da: And finally, what can we look

forward to from you next?

SE: | want to follow my path quietly, and keep
on creating art that is meaningful to my life
and to the people who are connected to it. I'm
currently working on a new series which will
allow me to refine my style and what I have

to say. I'm reflecting on how I can take the
medium of drawing further. It would be great
to show my work in a solo exhibition, so | will

have to try to find the right gallery for it. ®

Thank you Sam for taking the time
to speak to 2dartist today!




Désincarnations - pen, ink, and pencils on paper - 2 x 30” (2014)




Sean Andrew Murray
seanandrewmurray.com

Sean Andrew Murray
is a freelance concept
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Step inside Sean’s extensive
fantasy world through the
sketches that conceived it...

My father tells me that my very first drawing
was on the underside of our living room table,
which I had crawled under with some crayons
at the age of two. Since then, | have always
had paper and pencils with me wherever |

go. When | was young, you could usually find

me in my room drawing my own comic strip

characters, or my own version of Transformers.

I fell in love with fantasy after reading a
copy of Lord of the Rings that my stepmother
let me borrow. This inevitably led me to
playing Dungeons & Dragons with a small
group of close friends, all of whom loved

to draw as well. We would create elaborate
campaigns complete with our own hand-

drawn maps and monster manuals.

In high school in the early 90s | started
experimenting with digital art and keeping
a sketchbook - something I credit my high
school art teacher, Mrs. Hammonds, with
encouraging us to do. This is a habit that
has stuck with me ever since. In college |
studied illustration, but it was also when |
began to find my own unique voice in my
sketchbooks. They were a place where | could
experiment free from judgment or scrutiny.
To this day | always keep a sketchbook with
me wherever | go, and it has become an
invaluable tool for the development of my
own personal IP: The Great City of Gateway.

My sketches have also helped me throughout
my career. Most recently, at San Diego Comic-
Con in 2014, film director and producer
Guillermo del Toro bought the printed
version of my sketchbook at my booth,

and soon afterwards hired me to work on

a TV show he was producing, and also to

illustrate his Young Adult novel Trollhunters.

Lately, | have been working to build and
expand my personal IP, Gateway, which is
a fantasy world based around a huge city
bustling with wizards, magic and intrigue.
To this end, | recently launched a Patreon
campaign to give my fans and followers an
opportunity to follow along as | develop
Gateway, and even have a chance to help
me decide which corner of Gateway to

explore in drawings and paintings next!

52 2DARTIST MAGAZINE

“My largest source of
inspiration has been the world
around me. Opening my eyes
to the idiosyncrasies of human
life, and the things we build”

Inspiration and ideas:
I find inspiration all around me, in daily life, in

the cities and towns that | travel to, in books

that I collect, and in the movies | watch. As a

kid, if  wasn’t drawing, you could usually find
me with my nose buried in a fantasy novel or

a comic book. | remember the animated films

of Ralph Bakshi and later Hayao Miyazaki, as
well as Jim Henson'’s films; The Dark Crystal and
Labyrinth were particularly influential. The works
of artists such as Frank Frazetta, Boris Vallejo,

Brom, Bernie Wrightson, Brian Froud, H.R. Giger, »

SEAN’S SIGNIFICANT ARTWORK
The Nightfishermen

The Nightfishermen is one of my personal favorites, and represents an image that | believe

hits all of the right marks in terms of what | both love about art and wish to achieve in every

piece | create. There is a certain amount of quirkiness to the characters, and an expression

of atmosphere and mystery in this piece that perfectly expresses the world that | travel in

my own daydreams, and that | sometimes see hints of in movies or books, but have always

wished to explore further in my personal artwork. This piece is also a perfect snippet of

what daily life is like in The Great City of Gateway, the fantasy world | have been creating in

my sketchbooks and personal illustrative work.




® Another vehicle exploration exploring the idea of m'c as an energy sourc
resulting in different kinds of designs for modes of transportation
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Mcebius and in particular, lan Miller (especially
the work he did for Warhammer) made a huge

impact on my desire to become an artist.

Laterin life | began to appreciate the works of
old Masters such as Albrecht Durer, Hieronymus
Bosch, Leonardo da Vinci, and Pieter Bruegel

the Elder, as well as the classical illustrators
Gustave Doré, Arthur Rackham, Alphonse Mucha,
and Kay Nielsen. But the list certainly does not
stop there. | have an extensive library of books
featuring art and artists that | admire and am
inspired by, including a lot of “art of” books

for films, but there are too many to list here.

Lately, my largest source of inspiration has been
the world around me. Opening my eyes to the
idiosyncrasies of human life, and the things we
build, has been a constant source for developing

my personal project: The Great City of Gateway.

“In order formetodoa
great painting, | have to
have a fully fleshed-out and
realized drawing”

Materials:

My main tools for art making have been fairly
consistent over the past fifteen years or so.

| use Bristol board, mechanical pencils, a
mechanical eraser, and a kneaded eraser for
the analog materials, and Photoshop, Cintiq

and a scanner for the digital materials.

I do like to experiment occasionally, but these
tools have worked best for me over the long run.
I used to do a lot more pen and ink work, usually
with Rapidograph pens or nib pens, and | am
now attempting to work these materials back
into my process. | swear by the Alvin Draft/Matic

0.3 mm mechanical pencil with B Pentel leads.

In terms of painting, in the past | have favored
watercolor and acrylics, and on the rare
occasion | do an original painting, those are
my go-to materials. | experimented with oil
paints in college, but did not enjoy it or get the
results I wanted. I think much of this has to
do with the fact that | see myself as someone
who draws more than a painter. In order for
me to do a great painting, | have to have a
fully fleshed-out and realized drawing. This
doesn’t mean, though, that someday | won’t

pick up oils again and see how it goes. »

Channeling an inner lan Miller here - though abstract, this represents one of the darker corners of Gateway
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Here is an example of a sketchbook spread exploring multiple ideas. The guy on the right is a result of a totally abstract shape sketch
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Some sketches from life drawn while exploring the ancient, narrow alleyways of Old Jaffa City in Israel while on a business trip
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® Victorian-style vehicles, powered by magic. Lately tl'ier_e,-h‘avfe_ Eg’_e‘ﬁ"a'l’c;t
more vehicles and modes of transportation in Sean’s sketchbook g
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The Train Depot. Sean loved trains as a kid, and spent hours staring at photos of old steam engines.
This piece is one of several inspired by those images
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® The Multi-Wizard, this guy is the result of a successful,

but morally-suspect wizarding experiment

2DARTIST MAGAZINE
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“1 “find” or “arrive at” the
idea, rather than starting
with a pre-conceived idea and
chasing it down”

Sketching techniques:

One of the main techniques | use when
sketching is the concept of starting with
abstractions. | may not always know exactly
what I am going to draw before | draw it. |
will usually begin with the exploration of a
shape, or the application of a shape to an

idea that perhaps seems incongruous.

The final outcome of the drawing is a result of
going through that creative exploration. | “find”
or “arrive at” the idea, rather than starting with

a pre-conceived idea and chasing it down. The
best analogy I have is when we find imagery in
things like clouds or ink blots, and so on. Your
imagination kicks in here, attempting to find
meaning in the meaningless. This, in my opinion,

is the most creative and fun way to develop ideas.

The tricky partis to apply that approach when
attempting to solve a particular visual problem.
You have to avoid the temptation of letting
your mind imagine the solution before you
even start drawing, but all the while keeping
that end goal in the back of your mind. This

is harder than it sounds and | sometimes
struggle with it, but it's not impossible. When

it works, it’s a lot of fun because you get to
discover the solution for the first time, just as

those who will view the image after you do.

Something else which | find helps me a lot
in my sketchbook is starting with a box. Just
having a small, simple parameter to work
within helps me to focus and not get lost in

an endless number of potential directions. ®

® Fish-people heads. Fish people are a
common sight on the streets of Gateway
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© Prison City is a small, island-based district of The
Great City of Gateway. It is home to the Known
World’s largest felonious wizard population

e

Would you like to see your sketches
featured in 2dartist magazine?

We’re always on the lookout for talented artists
and their artwork to adorn the pages of our
magazine. If you think you have what it takes,
get in touch!

To submit, simply email Annie at
annie@3dtotal.com with a selection of your
images or a link to your portfolio online, plus a
little information about you.

We look forward to hearing from you!
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Art Gallery

Each 1ssue the 2dartist team selects 10 of the best digital images from around the world. Enjoy!

e
¥ -
Citadel Splendor !
André Pinheiro r

~ Year created: 2017

Web: andrepinheiro.artstation.com
© André Pinheiro
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Submit your images! Simply email annie@3dtotal.com
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Shipyard #2

José Julian Londorio Calle

Year created: 2017

Web: handsdigijtalstudio.artstation.com

© José Julian Londofio Calle |
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Year created: 2016
Web: danielbogni.com

© Daniel Bogni
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danielbogni.com
art@danielbogni.com
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On a dark planet
Vladimir Manyukhin (Mvn78)
Year created: 2017

Web: mvn78.artstation.com

© Vladimir Manyukhin (Mvn78)
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crashing

Tony Zhou Shuo
Year created: 2017
Web: artofzs.com
© Tony Zhou Shuo
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Happy Year Of The Rooster! [2017]
Sudhan L.

Year created: 2017

Web: artstation.com/artist/sudhanl

© Sudhan L.
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fORKSHOp

An innovative and fun way for people
of all ages to find the inspiration to
pick up a pencil — and draw!

The Sketch Workshop incorporates a luxury
leather-style folder that can securely hold a
workbook and up to 20 quality drawing tools.
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magic effects: water |

llustrator and artist Klaus Pillon explains how to use photo references to
create believable water magic effects
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primary love: 2D artwork.
Largely self-taught, he has
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2013 for games and movies.
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In this tutorial | will show you how to speed
paint an illustration of a water wielding mage.
We will cover the use of thumbnailing and
sketches to find an interesting composition
that will put the focus on the magic effect but
also reveal an interesting character, and how
to think about your lighting depending on

the needs of the illustration during the first
steps of the painting. You will then be able to
see how you can research, use, and rely on
photo references to understand your subject
matter. This will help design a convincing
effect that will in turn help you when choosing

your color palette and mark making.

O 1 Let’s start with a few
sketches; line sketches are a quick way

to lay down a composition as well as the pose
and basic character design, without worrying
about values or colors. At this stage it is important
to see if yourimage is powerful and reflects what
you want to portray. For this illustration we will
be putting the emphasis on the water magic and
the mage character will be secondary, so you

will want to keep the composition quite simple.

In order to better understand how water behaves,
I recommend you spend a bit of time looking

at pictures of water in motion, especially high
speed photos. References are definitely going

to help you find good movement for the water,

to show the mage controlling the water.

As you work on the sketches you may want

to recycle some of the ideas from previous
sketches to get the look you want. For example,
I like the idea of the mage being in the water,

so | recycled this in my third sketch.

“Looking at your
references will be very
useful at this stage to help
you understand the colors
that you can find in water,
depending on the lighting
scheme that you choose”

02 You have the lines
and basic composition/design sorted,

so you can start laying down some values on a
separate layer below the line sketch, or with the

line layer set to Multiply on top of the values layer.
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® Doing a few different sketches allows you to
explore different directions for the image

® Don’t think about details just now, the goal of this step is to get the values of the big shapes




Thisis a crucial step as it will dictate the abstract
impact of your image. You should think about
silhouettes and how to use them to make the
character pop, and how you want the viewer’s eye
to move across the page, using positive versus

negative space to create an interesting silhouette.

This is also the time to think about the lighting
because values, silhouettes, and light are closely
intertwined. Having the light at the top left will
make the character’s face pop and help the

water to stand out. This choice of lighting is also
dictated by the water effect itself as the references
will help you understand how the light should hit

the water for the effect you are trying to create.

Color sketch: The next step is to put
03some colors on top of this sketch.
Looking at your references will be very useful
at this stage to help you understand the colors
that you can find in water, depending on the
lighting scheme that you choose; for example,
the colors won’t be the same at high noon
than during a sunset. Using a layer on Overlay
blending mode, | start adding some colors on
top of the black and white sketch, which will be

the base color layer that you will build upon.

When you are happy with the base color, cut
the main elements of your image (the character
and water in the foreground) and put each one
on its own layer, then merge with the line layer

that goes with it; this will help with future steps.

Create a new layer for the background and

use a couple of textured brushes to begin
applying new colors with a painterly approach.
You don’t want to define too much, instead
focus on showing movement as you want

the background to contrast rather than

compete with the detailed foreground.

Refining the composition: You
04shoutd have almost everything ready
to start the detailing/rendering phase of the
process. Take the opportunity to adjust the

composition - this is where having elements

on separate layers comes in handy!

In my illustration | decide to remove some of the
water from the left to create a more interesting
silhouette and add more movement from the
top left corner to the end of the character’s

arm on the right side of the picture. To help

make the silhouette stand out more against the
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Use the background as a sounding board to help you make color choices

Don’t be afraid to make big changes, especially early in the process

background create a new layer set to Screen

mode and paint some light coming from the left.

In order to enhance the focus on the character,
put some notes of warm reds that will contrast

with the cool colors of the water an Overlay

layer; this will attract the viewer’s eye towards
the mage. You may want to crop off the bottom
part of the canvas, this serves to bring the
character closer to the viewer. It is a good idea
to explore and reassess your image as you

progress, which keeps the process organic. »-
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Refining the character: Even though
0 5this tutorial is showing you how to create
magic effects, the main focus of your illustration
will still be the character because this is what
the viewer will be looking at first and foremost.
Defining and detailing the character before you
work on the rest of the image will help you to
work out the amount of detail and rendering the
rest of the painting needs. So keeping the main
source of light in mind, you can start to refine
the mage; | have chosen to make my character
very pale, with blue-gray skin reminiscent of

a shark - this helps to link him to the water.

Water is a reflective material so you should
also pay attention to how it reflects the light
back on to the character, to help ground him
in the environment you should light him from
below with a blue-green tint. | recommend
using references for the pose, especially the
hands; you can easily find references on the
internet or just take your own, they will greatly
help with the realism of your illustration.

Refining the background: Now that
0 Gthe character is mostly done you may
want to make his head stand out even more
to push the focus on to it. To do this create a
new layer set to Screen mode on top of the
background layer, and with a dark blue-green

add more light behind his head, as if the sun
is hitting the top of the waves behind him.

When you are happy with the mage you can
move on to refining the waves. For this you
need to understand how light and water work
together: water is colorless but highly reflective
and is capable of reflecting all the colors in

the environment. At the top of a wave is where
sunlight directly hits the water and it is mostly
the sun that is reflected back, whereas lower
down on the wave is where the sky is reflected
back and will appear turquoise, and finally the
darkest part of the wave is the ground reflected

back on the water and will be dark blue in color.

The still water effect: Here we want
0 7the water magic effect to appear as if
the water is still to help sell the narrative that
the mage is in control of the water. With the help
of high speed photographs you can break up
the different colors of the water in order to get
a better understanding of how the reflection
works and recreate the effect in your illustration.

For the foreground water work closely with the

2DARTISTMAG.COM

Use references for difficult areas of anatomy such as the hands

Use a hard brush to get sharp edges on the reflection




references to paint the water, after that it is just
a matter of artistic choice on how you want

to stylize it. Make the outer parts of the water
reflect the light from the sun using an almost
white color, and add a couple more highlights
inside to show that the water is not completely
flat. The darkest colors are the reflections of
both the character and the ground below, and in
between there is a range of colors which are the

refraction of the sky and waves behind the water.

Varying the water: Once you have
0 8the main still water effect done you
can go on to refine the rest of the water effects;
you will want to make sure you add variety to
the water to create interest and movement in
the illustration. To paint in the different colors
of the water use at a hard brush and carefully
make the marks along the edges of the sketch.
Try to create a clear movement with each

wave, as if the water is slowly moving up.

You will also want to have the water increase
in motion the further away from the character
it gets, and in order to do this switch between
hard and soft brushes as you move further
away from the mage. This will also help

have the focus stay on the still water that is
closer to the character. Be careful not to over
detail the water in too many places and also
don’t go overboard with texture, instead try
playing with the contrast of simple versus

complicated to lead the eye over the image.

“Layer masks are great
because if you erased a part
you shouldn’t have you can
always bring it back”

Smaller details: To add a bit more
0 9detail and dynamism to the waves
itis a good idea to add some water and foam
droplets that follow the movement. Apply drops
on top of the waves, or where you feel that the
movement of the water is breaking. To do this
use a couple of different dotted brushes on a
new layer on top of everything. Apply the strokes
and then create a Mask layer to safely erase what

you feel doesn’t work or where it is too much.

Layer masks are great because if you erased
a part you shouldn’t have you can always
bring it back. You also need to be careful
not to create dots that are too similar in

size and shape as this will result in a loss of
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Play with your brush settings to familiarize yourself with them, and you might also discover
something interesting!

dynamism and movement in your work.
Contrast is your friend every step of the
way. With another textured custom brush
and with the same layer mask technique
you can also create some foam on the
surface of the water that will add detail and

movement, as well as adding some depth.

Last adjustments: Before calling it
1 Oa day you should spend a bit of time
playing with the colors, levels, and saturation to
see if you can enhance the overall look and feel
of the piece. For this you can use a lot of different

tools; the best way is always to explore and play

with the features in Photoshop, you never know

what kind of happy accident you can stumble
upon! Use a Levels adjustment layer (Layer >

New Adjustment Layer > Levels) to increase the
light in the background and use the layer mask to
paintin the light. This allows you a greater control
over the areas you wish to lighten or darken as

opposed to having an overall contrast increase.

With another layer set to Screen use a dark
blue-green color to paint a little bit more of the
reflective light at the bottom of the character. Be
careful to use these changes in a subtle manner
otherwise you can end up with too much contrast
(lights too light or darks too dark). With these

last minute adjustments done you are finished! ®
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Capture a
changing seascape

Concept artist Eduardo Rodriguez shares his top tips for painting a
plein air seascape, and handling a constantly moving environment ©




The Artist
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erodriguezart.blogspot.co.uk

Software Used:
Photoshop

Eduardo Rodriguezis a 2D
artist who enjoys concept
art and illustrations. He is
currently a freelance artistin
Los Angeles and works in the
mobile game department at
Disney Interactive.
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See how layer masks can
help you quickly adjust
your plein air scenes...

This is a digital plein air painting tutorial of
a beach scene. Plein air painting is the art
of painting from direct observation of the
subject matter and the subject matter is
usually landscapes. This practice has been
around since the time of the Renaissance
art masters and it is used to study and make
finished art pieces. What has changed are
the tools used to create plein air paintings.
The traditional oil paints, brushes, and
canvas can now be replaced with a digital

device, stylus, and painting software.

The benefit of doing digital plein air painting
is that you can directly apply what you learn
in the field to the work you do in the studio.
You will study light in different scenarios
and how it affects different materials. The
techniques and workflow you use in the
field will be the same as those you use in the
studio. By using the same digital tools in the
field and in the studio, it will improve your
knowledge of the tool and make you faster.
Also, you won’t have to worry about paints
getting on your clothes or running out.

I learned digital plein air from Shaddy Safadi.
This method of painting makes full use of

all the features in Photoshop. Among other
things, it embraces the use of layers, texture
brushes, color menu adjustments, and the
ability to make adjustments. However, many
other painting software have similar features

and so you can use the same techniques.

Workflow set up: Digital plein air
0 1starts athome with your digital device
set up. | use Photoshop, a Wacom Intuos 4,
and a Dell 15 inch laptop. Open Photoshop
and arrange your windows in a way that makes
it efficient for you. Since | am right handed, |
like having all my windows on the right side
and my digital canvas on the left side. Also, set
up hot keys (or shortcut commands) on your
keyboard and Intuos. With enough practice,
using hot keys will be automatic and faster

than manually opening menus and clicking.

0 2 Understanding layers: This digital
plein air process depends heavily on

layers. Therefore it is important to understand
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A parent layer can have several clipping mask layers. All layers can have a layer mask and

transparency lock

how to use them. Paint the silhouette of an
objectin a layer (a parent layer). Create clipping
mask layers by holding the Alt key and clicking
on the gray line between two layers. Clipping
mask layers are identifiable by the downward
pointing arrow. Create a layer mask by clicking
on theicon (circled in purple on image 02).
Lock layer transparency by clicking on the icon
(circled in green). Put all the layers in a folder to

make global adjustments or collapse layers.

Equipment set up: You have to
03 have the right equipment to be able
to paint comfortably outdoors. Start by fully
charging your digital device. You might want
to pack an extra battery, external charger, or
AC cable. For the set up, have two camping
stools; one for your computer and the other for
you. Put your laptop inside a collapsible black
box. You can visit Shaddy Safadi’s website to

learn how to make a collapsible black box.
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Use a tripod and clamp to hold an umbrella.
Depending on the place and weather, you
might not need to use all the equipment.
Other helpful things to have are: a smart
phone, head phones, snacks, appropriate

clothing, hat, and finger cut gloves.

“Nature presents you with
infinite compositions.
Your part as an artist is to
make design choices to
improve them”

0 4Ph°t° compositions: The joy of plein An example of the tools you will need and how to set them up
airis that you get to travel to beautiful

locations and paint them. Nature presents

you with infinite compositions. Your part as you can create several compositions from one composition studies. | like to use photos.
an artist is to make design choices to improve site. You can use a view finder, your fingers Photos are also useful for recording moving
them and tell a story. Image 04 illustrates how (as movie directors do), or sketches to make objects such as waves, animals, and lighting. »

Photos can be used for reference and digital composition studies
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Composition principles: The rule of
05thirds is a good way to start framing
your composition. Place your main focus on
one of the four places where the lines cross.

In the chosen scene, the main rock is on the
upper-left cross point. Other design principles
to consider are: eye movement, scale, and the
contrast of detail areas. In the chosen scene, the
rocks, horizon, and background guide the eye
to the main rock. There are big, medium sized,
and small rocks. The rocks have a lot of texture

and details while the sand and sky have fewer.

Layout in silhouettes: Zoom
0 Gout of your canvas to work small.
If the layout looks good in thumbnail size
then it's going to work in any size. This is

the most important part in the process, so

take the time to create a good layout.

The layout will consist of silhouettes. Use
grayscale values to separate foreground,
middle-ground, and background objects. Focus
on shapes, scale, and placement. Consider
how shapes relate to each other and put

each major object in its own layer. Lock the
layer’s transparency when you are satisfied
with the silhouettes. Remember to save your

file now and then as you continue working.

0 7Shadow mapping: The first set
of clipping mask layers are used

for the light planes. You can also work

scale difference

O most contrast

aye (main) focus

©® Most, if not all, design principles are based
on organizing contrast in areas such as scale,
less confrast
texture, shapes, and color temperature eye rest

© Work small (zoomed out) to solve big problems and
work large (zoomed in) to solve the small problems

@ Use a clipping mask to map shadows or light planes. Then lock

the layer’s transparency to preserve the edges W

© Take photographs of things that move constantly, such as waves

2DARTISTMAG.COM




Squinting your eyes will also help you see the average color of shadows and lights

inversely where the silhouette layer is the
light planes and the clipping mask is the
shadow planes. Group all light planes into
one value. Squint your eyes when viewing the
real scene to help you group the values.

Let the real light and shadow planes guide
you but design them when you place them
in your painting. In this painting, | designed
the light planes in a way that help guide the
eyes towards the giant rock. At this point,

start using texture brushes to refine edges.

“With things like waves that
are constantly moving, you
need to observe them to
understand their behavior”

Add waves and ripples: The
0 8painting process is one of continual
adjustments. Make the value of the water
dark then in a new layer, design the waves

and ripples in a lighter value. With things like

waves that are constantly moving, you need

to observe them to understand their behavior.

Paint the gesture of the wave and ripples.

Also take into consideration that the wave
and other elements follow perspective.
Strokes should get smaller as they move
back into space and straighten (horizontally)

closer to the horizon. Adjust the value of the
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Use variations of colors and textures throughout the painting to create harmony

mountain in the background to separate

it from the new value of the water.

Local colors: Color is relative. It
0 9needs to be compared to another
color to be able to form an opinion about
it. Use the Hue/Saturation/Brightness (HSB)

color menu to select colors. Look at the

real objects and paint its average color.

Paint in solid color, using the Paint Bucket
tool to fill in shapes. It will make it faster.
Locking transparency will keep color within its

parameters. Adding color might reveal areas

where you accidentally painted in another layer.

For example, you may accidentally paint water in

the sky layer. Clean up things like this as you work.

Color and texture variation:
1 OUse the Eye Dropper tool to select
a color that already exists in the painting.
Create variations by slightly moving the
Hue, Saturation, and Brightness sliders in

either direction. Change the temperature of

a color by moving the saturation slider.

Apply the colors with the fewest amount
of strokes possible so the texture of the
brushes remains visible. Start with large-sized

brushes and use smaller sizes as needed. »
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You might make a stroke with one brush and
erase or paint into its edges with another

brush to vary the border between colors.

Modeling forms: In an overcast day,
1 1there isn’t a significant value change
between light and shadow planes. Planes might
be hard to see in the real objects so apply your
knowledge of how forms turn. For example,

in a cube, each plane has a different value.

In a spear, there is a gradation of values.

“The sand tones gradually
get cooler as they recede
into the distance because of
atmosphere perspective”

In the giant rock, | copy the shadow

clipping layer. Use the Hue/Saturation color
adjustment window to create a darker and
more saturated version. Apply a layer mask
and fill it with black. Paint with white to reveal

the darker planes within the shadow side.

Refining water: In a way, painting
1 2vvater is the painting of reflections. There
is more color variation in the shore because of
water transparency and reflections. The color

of the sand mixing with the reflection of rocks

and sky are the main elements of the wet sand.

In the center of the image, the darker saturated
colors are reflections of the surrounding

rocks. The cool light grays on the right side

of the tide are reflections of the sky. Use a

layer mask in the wave layer to design the
shapes of the ripples. Use a texture brush

to paint the splashes in the waves.

Refining sand: The sand tones
1 3 gradually get cooler as they recede
into the distance because of atmosphere
perspective. Create the gradation by using the
same technique as in step 11. Make a copy of the

sand layer. Use the Hue/Saturation adjustment

window to make the layer darker and saturated.

Use the Color Balance adjustment window to
modify the hue of the layer. Thisis similar to a
wash in traditional painting. Apply a layer mask
and use a soft airbrush to blend the layers in
such away that creates a graduation from warm

foreground sand and the cooler distant sand.
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Value change is form change. Colors in shadows tend to be more saturated

Paint the gesture not all the details of the wave and ripples

PRO TIPS

Practice at hom

If you are new to digital plein air, it is good to start in your back yard or near your house.
That way, you practice the process of setting up the equipment, painting, and packing. By
doing this at home, you can easily, quickly and comfortably make modifications. It might
be that you need some bungee cables to stabilize your umbrella. Or you might discover
that you like listening to music while you paint and so you might need to make a music
playlist for times when you are in areas with no internet reception.

Art reference

There are two types of references; real world and art. Real world references are to help you

understand how the real world looks. In plein air, your real world reference is the scene
you are painting. On the other hand, art references are artworks used to guide art styles

or techniques. Set an intention of what you want to achieve with your digital plein air
painting. Then find an artwork that demonstrates what you want to achieve. Keep it simple
and only use one art reference image open in Photoshop. Refer to it as needed.




Create a feeling of atmosphere perspective by making a gradation of warm to cool tones in the sand

At a later time you can revisit your painting and make any adjustments necessary

14Homeshop: Adigital plein air
painting might not be completed

on site for several reasons; time restriction, a

weather change, a digital device running out
of battery, or you are hungry or tired. If your
goal is to finish the painting, reopen the file
at a later time and continue working on it.
One of the benefits of this is that you will see

the painting with a fresh eye and be able to

identify areas that still need adjustment. Blur
edges of objects in the distance. | add sand to
the bottom edges of some rocks and remove

the hook from the top of the main mountain.

1 5 Frame it and sign it: You can add a
digital frame to your painting. Make a
duplicate file. Merge all the layers into one. Copy

that layer. Navigate to Image > Canvas Size. In the
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Canvas Size pop up window, check the Relative
tick box. Add the size of the desired border
then click OK. Adjust the color of the border. |
usually color pick from the painting. That way
the frame falls within the color harmony that
has already been established. Lastly, add your
signature. | will often type my signature on the
border. You can also color pick and adjust the

value so that the signature is visible but subtle. ®
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Plein air
paint a ruin

Discover a new approach to painting stylized environments
with freelance digital painter Maciej Sidorowicz ©
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freelance digital painter
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Work from real life to
refresh your environment
painting processes...

In this tutorial | will share with you my
approach to digital plein air painting. | think
the most important thing here is observation-
understanding-redesigning. By observation |
mean finding something that touches you and
makes you stop and marvel for a moment. You
have to grab the essence of this thing, and this

is where the understanding part comes in.

You have to determine why what you see

in front of your eyes is so special - is it

the colors and shadow during the golden
hour, or the composition of trees, or the
shape of a road? Then, once you’ve grasped
this, you have to apply it to your painting

- make it a bigger, better idea instead of

just copying what is in front of you.

Use it only as a direction and look for

the answers to your questions (what are
the colors of the shadows? How does

the light react with different materials?)
When you have those answers, the picture
then becomes your interpretation of

what you see. Sounds easy? It can be.

0 1 Finding the spot: When looking
for a place to do some plein air
art you should find somewhere that has

something special or exciting about it.

For this tutorial I have chosen to paint an
abandoned gas plant in Warsaw, Poland

- | like it because it looks like a big, empty
shell with interesting brick textures, and the

broken windows give it a haunted look.

As you will be spending some time there itis a
good idea to learn about the location/building; |

read up on the gas work’s history and watch a film

about some urban explorers who investigated it.

I recommend that you take lots of photos of your

Get down the basic line work of your composition

chosen spot to use as reference later, and also

just to add to your visual library. Taking these

steps will help you to better understand what you Procreate app, but you should use whatever

“Tl"y to find ways to are painting and to add a bit of soul to your art. is right for you. At this stage, explore ideas
emphasize the parts that and experiment with composition, but make
you like, resulting in a more Sketching: Now you have learned sure you use what you see as a reference. Try
interesting painting” 02aboutyourlocation,you are to find ways to emphasize the parts that you
ready to begin. I like to use an iPad and the like, resulting in a more interesting painting.

2DARTISTMAG.COM



2DARTIST MAGAZINE | ISSUE 134

The light issue: When doing plein
03 air painting you can’t change or
control the lighting conditions, so it is useful
for you to know some basics of how light works
under different conditions. For example, when
I was painting the gas works it was a cloudy
day, the light was neutral and diffused, and
there were no sharp shadows. Pick one of the _
composition sketches to work with and start ' '

sketching in the line work on a new canvas.

You only need to get down the basic shapes as

you will work on the details at a later stage.

® Build up the painting by starting with the background

04Start painting: | prefer to start my @

paintings with the background and

move forward through the planes until | get to
the foreground. It is important to keep each plane
on separate layers so you can easily play with
your composition and rearrange it at any point.
Pick some colors to match the environment and
loosely paint a sky in the background. To quickly
add vegetation such as trees and bushes, use the
Lasso tool (L) to roughly follow the shape of the
tree and paint inside that shape. Do not use the
Lasso tool to fill the shape with flat color if you
want more natural looking vegetation, instead try

leaving some space and irregularities; the Lasso

tool is perfect for keeping the shape of the tree.

055tory inside the painting: It’s always
good to have a bit of extra narrative . . .

® Giving the buildings personality can add depth to your work
inside every painting, even if you are doing » @

L ——
P -
=t

Keep adding details to build up the story
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® Continue to move forward through the planes, adding details as you progress

a practice painting or plein air. For example,
I'thought that all of the buildings look like
characters - the gas works is a big, menacing
bully, while the other two smaller ones are
cowering next to him, a little overwhelmed
and intimidated by the big guy. This is just one
possible story | could apply to this picture, it

adds spirit and interest to your paintings.

Quickly block in the buildings, adding a little
personality to them if you want to; don’t be
afraid to adjust the shape and sizes to give the
composition a bit more impact. Continue to
build up the big details such as the buildings;
remember to keep each plane on a different

layer so you can make adjustments.

Moving forward: Now is a good time to
0 Gmake any changes to the composition.
Use your initial sketch from Step 2 for guidance,
turning it on and off as often as you need to.
Once again | recommend you use the Lasso tool
to paint in the shapes of the next plane. In my
painting | painted in simple shapes to create
the ground and fences, and used the Lasso tool
to add variation and texture. You do not need
to paint all of the fine details of every building
or part of the picture because you do not want

to overload the viewer with too much detail.

2DARTISTMAG.COM

It is much better to paint the parts of your

painting that you want the viewer to focus
on in more detail, and leave everything else
less finished. Don’t be afraid to reuse some
of your elements to build up the layers, for
instance | copied and transformed the tall
thin building and pasted it in the background

to add more interest in that area.

0 7Atmospheric perspective:
Atmospheric perspective is what you

® Increase realism by adding atmosphere perspective

see when the particles in the atmosphere cause
objects to appear paler and desaturated the
further away they are. This can be achieved by
gradually reducing the saturation of the objects
as they move back through the painting towards
the background. This is another great reason to
keep each plane on separate layers, it makes it
much easier to separate the planes of the picture
by layers of fog. This adds depth to the whole
piece. I'm also constantly moving the buildings

here and there to check if the composition



can be improved - however, remember that it
has to be clearly visible what’s behind what -

overlapping forms are a great tool to achieve that.

Faster!!!: As we are using Photoshop
0 8to paint digitally, we have access to a
vast array of tools and techniques that help to
speed up the process. To add details such as
windows or doors create one on a separate layer
and then use Copy (Ctrl+C) and Paste (Ctrl+V) to
duplicate it. You will probably need to transform
them to fit in with the perspective of the building.
To do this you can use any of the transform tools
such as Perspective or Distort (Edit > Transform
> Perspective or Distort). This is a much faster

method than individually painting each window.

Once you have placed all the windows and doors
you can add different details and textures to
them so that they are not all exactly the same;
this will help to break up the uniformity of the

duplicated details and also add interest.

“To Do” Layer: Often when you
0 9are working on your painting you
might get an idea that you want to implement
laterin the process. | like to use a layer that
I call “To Do,” placed on top of all the others
to jot down any notes or line art ideas.

You could put anything on this layer such as

story elements, composition ideas, or just extra

details. If you treat this layer like a checklist you
can make sure you have got all the elements
you want in your final painting. You are not
tied to using everything you put here; you can

just resign the ones that don’t work for you.

| recommend that you take a couple of hours’
break before you decide what to use, if anything;
this way you will come back with refreshed eyes

and be able to better judge what you need to do.

1 0 Finishing steps: Your painting should
be pretty much finished; you should
have all of the main elements and details in place.

All that remains is to add any of your ideas from

® Photoshop has many great tools for speeding
up the painting process - -

Using a layer to keep'ideas on is a good way to make sure your work has all the elements you want

2DARTIST MAGAZINE | ISSUE 134

the “To Do” layer and play around with filters to
give the painting a polished finish. | decided to
add a character standing in front of the gas works
to add a bit of life and interest to the painting.
Itisimportant to think about where you are going
to add these extra details, you don’t want to
distract from the main focus but rather enhance
the narrative. | like to resize my paintings down
by about 50%, this result is a much sharper and
clean look to the lines; | also overlaid a grain
layer set to 10% so it is only slightly visible, just
enough to add a bit of texture. And with the

final finishing touches added you are finished! @
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Fantasy fundamentals:
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Learn the essential rules
of perspective...

In this five part series | will guide you through
the fundamentals used to create a compelling
fantasy image! We will look at crucial aspects
of image creation including composition,
perspective, value, visual effects, as well

as a concluding segment that brings them

all together. Each of these elements will be
given their own article where we will be able
to delve deep into why they are important
and how they are applied. Becoming
knowledgeable in these areas will give you the
necessary tools to capture your imagination

and release it to the masses in all its glory!

In part two we are going to focus on
perspective. Now that we have the
composition set it’s time to refine the
physical elements in the scene to give it a

sense of realism. Having proper perspective

will convince the viewer that what they are
seeing is believable and that they could
walk into the scene to experience it for
themselves. | will be going through the types
of perspective you can use and explain how
it can bring your image to the next level.

What is perspective?: Perspective is
0 1the technique we use to represent 3D
objects in a 2D space. Using this technique will
convey the illusion of depth and dimension on
a flat surface in a way that feels believable and
natural. To do this we employ various types of
perspective including linear, atmospheric, color,
and planar perspective. When combined, these
techniques will create an extremely believable

scene that acts as a window into your vision.

Perspective is important because it opens
up a connection between the viewer and
the scene. When the perspective is correct

itinvites them in with a sense of familiarity

owing to the fact that the rules applied in
the real world also apply to the image. If
the perspective is warped or incorrect we
are unable to step through and imagine

ourselves within the scene as an onlooker.

The basics of linear perspective: The
0 2 idea behind linear perspective is that
you are using a set of rules to help guide lines
towards a vanishing point. Objects can then be
placed along these lines, gradually shrinking in
size as they recede back in space creating depth.
There are three main types of linear perspective;
one point, two point and three point perspective.
The one, two, and three represent how many

vanishing points there are in the scene.

When composing a scene it is good to figure
out which one will best suit your needs.
When it comes to fantasy | often find myself
implementing three point perspective the

most as it adds a real sense of scale and

® Accurately drawn perspective will invite the viewer
into the scene where they can immerse themselves
in your vision

One Point perspective

.

\

Three Point perspective

® Examples of how one, two, and three point perspective are executed

2DARTISTMAG.COM
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In this atmospheric sample, the dragon’s head appears further back because of the thick layers of dust in the air

grandeur. It has the ability to make you feel
smallin contrast to the grand exaggerations of
fantasy. In the accompanying image you can

see all three types of perspective in action.

“The further away an object

is from the viewer the less
contrast it will have. The color
saturation and details will
fade and the object as a whole
will generally shift towards
cooler tones”

The basics of atmospheric
03 perspective: Atmospheric perspective
is a method artists use to give the illusion of
depth and recession to a scene. The further away
an object is from the viewer the less contrast it
will have. The color saturation and details will
fade and the object as a whole will generally shift
towards cooler tones. This happens because of
the dust and particles in the atmosphere. As the
object recedes, more and more atmospheric
particles build up in front of it like thinly layered
sheets. These particles also reflect the dominant
light source, often times being that of the sky
which is why the blue tint is so commonly used.

Using atmospheric perspective can create
very dramatic scenes depending on the

amount of particles in the air. Using one of »

PRO TIPS

Using details to your advantage

Details can either enhance or impair an image. When used correctly it can bring your
subject forward, making it pop out of the image. On the other hand if it is overdone it can
actually flatten the image and you will lose all depth you’ve been working to achieve. | like
to focus most of the details into the main point of interest and gradually fade them out as
I'hit the secondary and tertiary interest points. Placing a heavily detailed subject over a
background with very little detail will have an especially strong impact.
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By separating your image into three distinct planes, each with their own value ranges,

your viewers can quickly understand the relationships of objects within your scene

By swapping the cool blues with warm reds the dragon is pulled forward, effectively making it appear closer to the viewer

the sample images from the composition
article, | have introduced depth through
atmospheric elements. By doing this | have

defined the space between the adversaries.

0 4The basics of planar perspective:
Another useful technique is to

separate your image into distinct planes

2DARTISTMAG.COM

(I'like to define three main planes; the
foreground, middleground, and background)

by doing this viewers are able to get a sense

of depth through comparing the layers.

With this method you can draw attention to
subjects that are particularly important to the
scene; this works because each plane has its

own variation of colors and values that help it

to stand apart from the other layers. You can
see this in the example image; by keeping the
foreground, middleground, and background in
their own value ranges | am emphasizing the
distance between the three, and highlighting
the skeletal figure. This makes it easy for the
onlooker to grasp the distance and relation

of objects to each other within the planes.
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The basics of color perspective: While
ossimilar to atmospheric perspective,
color perspective uses the whole range of hues
to help provide the illusion of depth. Colors
that are warmer will advance towards you while
cooler colors will recede away. If you want to
separate something from the background then
warmer hues should be used, likewise if you want

to push something back then cool it off a bit.

More so than the other techniques, color
perspective tends to stick around with me
until the very end of a painting. | am constantly
pushing and pulling between warm and cool
colors to make sure each element of the
painting appears precisely where | envision

it. By reversing the sample from atmospheric
perspective (Step 3) | have switched the dynamics
of the painting. The dragon now dominates
the scene. The values remain unchanged but
the beast is more threatening as if it is more
aggressively lunging towards the warrior;

this is all thanks to a swapping of hues.

“] like to try out a wide range
of angles so | can fully explore
all possibilities and ultimately
come up with something that
works best for the narrative”

Sketching out your options: Before
0 6plovving ahead, it’s always good to
sketch out a few thumbnails, this way you can
be sure to start your image off on the right foot.
I'like to try out a wide range of angles so | can
fully explore all possibilities and ultimately
come up with something that works best for
the narrative. At this stage I’'m not worried
about accuracy. I loosely scribble out an idea
until it begins to resemble something | like.
Then | go back and rough in the perspective
with help from the horizon line and vanishing
point; if I like it I'll move on to the next step

and refine the perspective using paths. »

Using the Transform tool for measurements

There will be times when you have same sized objects that need to be placed in
perspective. A good example of this would be windows on a building. Each window is the
same size, as is the distance between them. This can be tricky because as the windows
recede towards the horizon line they will appear to get closer and closer together.
Beginners will often guess on how close each window should be, not knowing that there

is a way to measure this, which can get quite technical. Fortunately there is an easier way!
With the Skew tool (Edit > Transform > Skew) you can have Photoshop do the hard work for
you. First create the plane in 2D then select the Transform tool (Ctrl+T). Right-click on the
selection and choose Skew, then it is just a matter of lining up the transform box with your
perspective lines!

i1
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Using paths to create perspective
0 7lines: To create perspective lines in
Photoshop | create paths using the Pen tool (P);
it takes a little bit of know-how to use effectively
but is very easy once you get the hang of it. First
select the Pen tool, and then pick the Line tool (U)
in the menu above. Make sure the Paths option is
selected then simply draw out your perspective
lines. If you decide to change your vanishing
point you can select the old points by holding
Ctrl while selecting with the Pen tool, and you

will be able to move them to their new location.

When | am happy with the perspective lines’
location I make a new layer and stroke the
path by right-clicking on the Stroke path

from the Path panel pop-up. The stroke will
imitate the size of your brush so make sure

it is set to the size you want before stroking
the paths. Now | have a grid that | can overlay
on top of my painting! If you want to create
another set of perspective lines, simply create

anew paths layer and repeat the process.

Irregular architecture: Structures
0 8don’t always line up with each other;
in fact it would be very odd if they did. This is
especially true when it comes to complex scenes
such as ruins or villages. So what do you do when

nothing shares a common vanishing point? The

foreground structures in the example are angled

differently and do not align with the rest of the
architecture, so | treat them as a new perspective
with their own vanishing point. No matter how
many perspectives you have in a scene, there
should always be a dominant perspective that
the others reside within, this way the viewers

can identify which elements are off-kilter. If all
the perspectives are fighting for attention then
the image will break apart and the viewer will

have trouble understanding what is going on.

Using 3D software: Nowadays it's
0 9 pretty easy to get your hands on free
3D software which is great for those who want
to jump in and create complex perspectives
without the tedium of traditional methods. With
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programs such as SketchUp or Blender you can
compose elaborate scenes quickly and effectively
making it a crucial tool in today’s industry. Please
note that I have added this towards the end of
the article because it is still very important to
understand how perspective works. If you skip
straight to using 3D without proper perspective
basics you will be making decisions without

a true understanding of what you are doing,

effectively making your scene a hit or miss.

Having in depth knowledge of a subject will
always yield stronger, more purposeful results.
Another benefit of 3D is the ability to test out
different angles and lighting. In the example you

can see how | use the strengths of 3D to figure out
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® Using paths to create a perspective grid is
an easy and malleable way to ensure your
perspective is kept in check

Create vector mask IE—
Delete Path

Define Cusstom Shape.
Make Sefection

Fill Path_

Stroke Path...

Clipping Path_.

Free Transtorm Path

The stairs do not line up with the rest of the perspective

so another is created to ensure continued accuracy
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Testing out different options in 3D helps to work out which architecture is most appropriate for the background

the most suitable shot. When | use 3D | generally
keep it pretty simple. I'm pretty decent free hand
so spending too much time modeling objects
just eats up time that could be spent painting;

this of course is just a personal preference.

1 oBringing it all together: By using the
techniques provided throughout this
article | have reached a point where | am happy

with what | have, and the thumbnails helped

me decide on which perspective would work

best. Challenging angles have been resolved
and an atmosphere has been introduced

to add a sense of depth to the scene.

Perspective can be challenging when you
are first starting out but like with all things, a
little practice goes a long way. By following
the rules of perspective | can be confident
that my image has the sturdy framework
necessary to build from. In part three we will

be looking at value; | hope to see you there! ®
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Learn how to paint a moody and melancholic narrative driven
illustration with Jan Welsbecher ©
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Learn how to paint a
moody and melancholic
narrative driven illustration
with Jan WeRbecher...

Hello there! I’'m going to show you the
painting process | used for creating this

piece. | had a very lengthy sketch process
beforehand, but we will mostly exclude that
here because it would go beyond the scope of
this feature. | will however talk about some
crucial decisions | made during the painting

process and highlight some techniques | used.

All the techniques and decisions | made
combined to get the certain filmic look | was
striving for. My main goal with this piece was
to show an intimate scene, like a snapshot
out of a dark, futuristic movie. The setting

is from a personal project of mine called
Celsius 13 and takes places on a colony
planet that has regressed back to a darker

civilization, after being abandoned by Earth.

All of the informed design decisions | took in
the painting led to moody lighting and a dirty,
smoky setting. Color seems to be drained
from the faces and a general air of desperation

reigns, but a small spark of hope still lingers.

&

&

The chosen lighting setup - one of about half gk
o
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“] like drawing and | don’t
mind spending time getting
the line art to a point where it
can stand on its own”

Initial drawing: As mentioned
0 1 before, | spent quite some time on the
drawing beforehand. This is actually the second
fully fleshed out drawing I did of the scene
before | started the painting. | was interested
in doing both as a painting; however, this
drawing better represented the things | wanted
to achieve. Going into this kind of detail and

doing expressive linework, and even shading,

is not really necessary but | like drawing and

I don’t mind spending time getting the line

art to a point where it can stand on its own.
Usually, anything that lays down the big shapes
and gives you a good indication on how the

composition will work is going to be usable.

For me, the drawing allowed me to quickly
define details, such as the wrinkled face of the
old woman; also, | could come back to it later

to check the painting against the line art.

O 25etting up the lighting: For this step,
I went in with the intention of trying
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out different lighting setups before | decided on
the final one. Using a rather broad and bristly
brush, as well as a soft round brush (so I didn’t
get bogged down with details or shading) |
quickly laid down the main light directions and
some reflected light. | ended up with about

six different black and white lighting layouts.
Some of these were a result of combining
previous ones by using Opacity and Blending

modes on the layers stacked atop each other.

Another possibility would be to use a flat tone
approach using an ink brush or the Lasso

tool to get sharp edges. It really depends on
your preference as well your intended result.
Since the end result of the painting wasn’t
supposed have a cleanly shaded look, | avoided

making perfectly defined pools of light.

Basic colors: | usually think to
03 myself that | will to stick to my
original color choices | make at the start of
a painting but often it changes as painting

progresses, nonetheless, | decided to set up a

very basic color layout to start the painting.

Using the Lasso tool and sharp edged brushes |
defined areas of different flat color. If you want,
you can keep all these on separate layers for later

use, either for easy masking/selections, or to

paint on top of them - that is a lot of clutter for
my liking so | kept it to one layer for this piece.

I keep the line art on top as a separate layer

to remind me of what needs to go where. In
hindsight I think I should have spent much longer
on this step than I did in the end as it would

have made the later stages much smoother.

bw lighting - multiply

O
O
O
O
O
L= ]
o

base flat colo

Combine lighting and color: Now
O4vve are getting to the more juicy parts.
I used the black and white layer on top of the
color layer set to Multiply mode (Layer > Layer
Style > Blending Options...) then | made two

copies of the black and white layer as well

as some of the other discarded black and »

121
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I had some good reference for the type of hair | was going for with

the woman’s braids - it was one of the most fun parts to paint
A

v

white layers (for example one which only had
arim light). | colorized the copies in different
hues using the Hue/Saturation adjustment
panel (Ctrl+U), then | put the colorized layers
on top and set them to Linear dodge (Layer

> Layer Style > Blending Options...).

After playing around with the opacities and some
layer masks, | got to a setup that worked well for
me. To add a little bit of glow to the whole thing,
I'used a merged copy in which | selected the light
areas, deleted the rest, blurred it using Gaussian
blur filer (Filter > Blur > Gaussian Blur...) and set

the layer to Lighten and lowered the opacity.

Starting the painting process: Now |
05had a solid base | could begin painting
on, I needed to work on the focus areas of the
image, such as the woman’s hair, the face of
the girl, and the helmet of the crone with all
the technical stuff. Throughout the process
I always try to see if | need to fix some of the
anatomy, and sure enough, there were quite a

few things | needed to fix right up until the end.

2DARTISTMAG.COM

Adding the monitors in the backgrounds helps define the room and gives a nice contrast




Carefully controlling your values is hard, but is
very important when working on dark scenes

At this point, | was mainly concerned with
laying a solid base on the crone’s helmet
and defining the girl’s face. Specifically for
the technical parts of the helmet, | collected
many references of old engines and grimy
machinery. | tend to find lots of inspiration
in doing a round of reference collection

right at the start of the painting process.

O 6Defining space: | do tend to jump
around a lot when painting, so with
every step, the whole painting progresses a

little bit, for example by adding more saturation

to the colors and depth to the background.

However, in this step there were some larger
changes. | was feeling rather dissatisfied with
how the background progressed and was
constantly changing it until | decided to add
monitors displaying grainy static to more clearly

define the room in which the scene takes place.

The displays were easy to block in, I just painted
a light-blue flat shape, added noise (Filter >
Noise > Add Noise...) then added a glow by
blurring a copy of the display on top of itself
and setting it to Lighten (Layer > Layer Style
>Blending Options...) These didn’t make

it to the final image, but the idea to create

more space by lighting up the background

proved to be a good decision in the end.

PRO TIPS
Telling a story

2DARTIST MAGAZINE | ISSUE 134

0 7 Pushing back values: One thing
that becomes rather important when

working in a low key image like this is the

separation of elements. For example, the woman
in the foreground holding the dagger is barely
visible; she is almost just a shape in dark colors.
However, the viewer should still be able to
clearly separate her from the elements behind

her and read the shape as a head. By painting a »

In my Illustration work, | am always concerned with having a narrative; | think that pretty

much all work can benefit from thinking deeply about what kind of story the viewer will

experience when he looks at your art. It’s nice to have an artwork that blasts you away with

technical excellence, but if that piece also touches you on an emotional level, then I think it

gets elevated to a whole other level. This doesn’t necessarily mean having a clear narrative

asif it exists in a book or a movie. It can be an abstract thing as well, although | personally

go for the “obvious” story telling more often than not.
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You shouldn’t be afraid to make necessary changes
even this late in the painting process

soft gradient behind her, | made her more visible depth of the image. To make the windows the woman’s hair much stronger without it
without pushing her into focus too much. | basically kept what | had painted for the standing out. | also finally got to work on the
Another important adjustment is the added monitors and just stretched their top part with clothing of the girl. Since it was supposed to
color contrast on the girl’s clothing and the transform (Ctrl+T) and painted over them. be part of the focus point of the image, | added
bowl with the pink liquid. By doing this, the a lot more detail and more natural folds to

girl clearly stands out as the main focus of Adding the windows also allowed me to make it, but still kept the loose fitting feeling of it
the image and at the same time becomes the blue rim light playing along the edge of (like something a sick person might wear).

more connected to the crone character. Using

color contrasts like this can be very effective PRO TI PS

when conveying narrative in an illustration. : R

Experimentation
Thanks to working digitally, we have the good fortune of being able to save backups.
This also means that it is quite easy to just go nuts for a little bit and throw large changes
around when you can’t put your finger on why something isn’t working. You might just find
a solution to your problem, for example, midway through this piece | changed the width of

“Adding the windows also
allowed me to make the blue
rim light playing along the

, .
edge of the Wom?n S ha."' my Image to make it feel less claustrophobic, and | could’ve just changed back whenever |
much Stronger without it wanted. This is a very powerful tool to have!

standing out”

On using reference
Windows from monitors: Finally! This I'm pretty certain that this isn’t the first time you will have heard this, but since | have to
0 in my opinion is the most important remind myself as well all the time: using references is very important and in a way it’s
similar to observing your environment and building a visual library. You just have it stored

change I made while painting. | realized that

changing the small monitors into larger vertical externally in addition to mentally, so you can always check when you forget what that one

windows would allow me to show the cables tree looked like that you photographed on your last vacation.
running through the room to cross in front

of a light background, thus enhancing the

2DARTISTMAG.COM




Depth of field like | used it here is a very technical solution. It doesn’t fit every style
and it’s important to know when to paint a soft edge by hand

Depth of field: Finishing up! After
O 9adding the last touches, such as a
finer spread on the girl’s hair and small details
like glowing incense sticks, details on fabric,

and adding window blinders for a more lived in
feeling; I decided to add a depth of field effect.

Since I hadn’t kept all my elements on separate
layers, I now had to cut the image into layers
again (you reap what you sow!). Afterwards it
was easy to apply a Lens blur (Filter > Blur >
Lens Blur...) to the separate layers, each with
their own value (more blur for windows in the

background, less for foreground elements).

Additionally, for the focal points | used the
Unsharp Mask filter (Filter > Sharpen > Unsharp
Mask...) to get a crisper definition of details.

You have to be careful with that however,

for some brush setups or styles it might
produce a very grainy result, or look worse
than without. Ideally, you should use a layer

mask to apply it only where it is needed.

Final color corrections: Usually |
1 Ohave a rather extensive color correction
setup at the end of my process, because I'm
never really satisfied, and | tweak it a lot. In this
case | tried unifying the colors more and adding
awarmer blue to the unfocused elements. |
used a combination of Adjustment Layers (with
additional layer masks of course), mostly Curves,
and a Gradient Map set to noise on low opacity
and selective color. Ideally, you don’t use too
many of these adjustments because it might
throw your values out of balance or make the
colors too uniform. The finishing touch for this

image was adding film grain. One method to get
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adecent grain is making a 50% gray flat color
layer, then applying the add noise filter and
blurring it with a Gaussian blur set to something
around 1.5. Afterwards set the layer to overlay and

adjust the opacity, and with that | was finished! @
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In this tutorial | will show you a relatively
quick and easy way to create a painting

with the use of some stock photos.

Creating perspective and composition

Begin by opening Photoshop, creating

a large canvas and setting a neutral
background color. | usually use a warm,
mid-gray as a base as opposed to the default
white as this can be a little stark. | find this a
good way to work as you can add contrast
(light and shadow) quite easily.

Next, create a new separate layer for the
sketch that will form the base of your image.
To create a new layer press Ctrl+Shift+N.

This is when you want to start to develop
your idea. At this point | already have a rough
idea of what | want to do: a giant spider
mech in a ruined city environment. With

this in mind | quickly sketch out the image,
concentrating on the composition and overall
balance. The brush you use isn't really that
important at this stage, but | prefer to use a
hard-edged brush as opposed to a soft-
edged airbrush.

Your aim at this point should be to make
some interesting shapes on the canvas and
create a sense of depth by adding some
perspective. It is also important to think about
the silhouette of the main focus of the image;
this should look cool and interesting.

Blocking the scene

With the basic sketch done, add another
layer that you should use to block out the
scene. | use the Polygon Lasso tool (L) to
create a crisp shape to work from. In images

02 and 03 you can see the way that | have
blocked in the mech. The black and white
line signifies the selected area. When | am
happy with my selection | fill the area with a
mid/dark gray by pressing Shift+F5.

With the basic shape in place, use the same
method to add some rough shapes to the
background. In my case | have added some
rough buildings. Although this method lacks
detail and will eventually be discarded it does
help me build a better image in my mind of
where | am going (Fig.04). You may find this
a useful step to start with.
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The next step is to gather some photo
textures from the free resources at 3dtotal.
com. These real-world photos are very useful
and help add some believability to the image.
They also allow you to quickly achieve a high
level of detail. This can be very useful if you
are up against the clock. It is a good idea to
start building up your own resource folders
S0 you have quick access to stock images,
textures and so on (05).

The next step is to start selecting the
elements of the photos that you want to use
with the Lasso tool. You can copy the area
by pressing Ctrl+C and paste it onto your

canvas by pressing Ctrl+V. Start with the
background. In my case | added the ruined
buildings and the rubble-strewn street.

When applying the photos to your canvas,
cycle through the blending modes in the
Layers tab to see what works best. | usually
settle on Overlay blending mode, but you can
always go back and change things later (06).

The aim at this point is to create a level of
harmony where nothing really jumps out at
you as being wrong. Adjusting the colors

and contrast of the various elements will
help them sit in the scene nicely. | often find
keeping a limited range in both your color
palette and values will help at this stage (07).
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With the background elements in place you
can start to begin work on the foreground —
in this case the mech. You should have all of
your images in a place that you can access
easily. At this point | had a canvas with all my
references on it and decided to use the arms
of a digger as the legs of the mech (08).

Make your selection from the references

and then paste it into your image. You may
need to transform the image a little to make
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it fit. To transform the layer or selection press
Ctrl+T. To bring up the various transform
options, right-click the active transformation
and a set of options will appear (09-10).

With the beginning of the foreground in place
the next step is to start to add more photos.
The same principle applies here as it did
with the background. Play with the blending
modes until you find the correct mode to
make the elements work well together. In the
case of my image | also used tools such as
Color Balance, Levels and Curves to balance
the colors and values (11). These tools can
be accessed by going to the Image menu
option and then going to Adjustments (12).

In the case of my image the basics were

in place, but the image was very flat and
monotone. My next goal was to play with
the color palette and establish some lighting
(16). Add a color wash to the image in Soft
Light blending mode. This is to help gel all

the elements together (13-14).
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Next use Levels (found under Adjustments
in the Image tab, as mentioned previously)
to balance the image and give it a natural
daylight feel (15). As you can see in the case
of my image there is still a lack of contrast
and directional light. To help add this, set up
another Levels adjustment layer (you can
find this on the bottom of your Layers tab —
see the top left insert in 16). My intention for
this adjustment layer is to boost the light in
certain areas of the picture. When applied, it

will initially affect the whole image, although
this isn’t a problem as it has a layer mask.
Use the layer mask to paint the areas you
want in shadow (using black as the color), or
paint in the areas you want in sunlight (using
white) (16).

After adding some basic light to the image
you can turn your attention to the colors
again. Use the various adjustment layers to
reduce the overall saturation and also boost
the blues in the shadows using the Levels
tool (17).

You can then flatten the image and begin
over-painting. At this point you can cover
up the mistakes you made earlier by adding
more lighting, atmosphere and detail (18).
When you are happy with the overall result
apply an Unsharp Mask (found under the
Filter tab) to really help bring out all the
details and highlights.

134 | 2DARTISTMAG.COM




2DARTIST MAGAZINE | ISSUE 134




The Artist

Alex Figini
artstation.com/artist/alexfigini




A-ﬂ.-nhﬂn._ E"u. .
e Rl B
a3 =i
= mm | .hl

© Alex Figini



Paint a sci-fi huntress
In-depth artist interviews
Fantasy scene fundamentals
Top ten gallery images

Enchanting fantasy sketches

Design an Egyptian guard’s costume

AND MUCH MORE BESIDES!




